Tutorial

Ontdek het geheime gereedschap van Photoshop,

waarmee je met een simpele druk op de knop
perfecte kleurtonen maakt

Of je nou een beginner bent of juist
een zeer ervaren fotograaf, het blijft
lastig om 's nachts of bij slecht licht
goede foto's te maken. Het liefst zou
je alle details uit de scéne willen
vastleggen, van de diepe schaduwen
tot de fonkelende straatverlichting.
Helaas gaat dit vrijwel altijd gepaard
met een grote hoeveelheid ruis.

Met ruis wordt dat vervelende,
korrelige effect bedoeld dat je vaak
terug ziet in afbeeldingen die gemaakt
zijn bij weinig licht, alsmede een groot
gebrek aan details. Gelukkig bestaat er
een manier waarop je bij elke
lichtcenditie de details kunt behouden
en tegelijkertijd kunt afrekenen met
ruis: High Dynamic Range (HDR).

Deze techniek combineert fotografie
en beeldbewerkingtechnieken, om
samen tol verbluffende resultaten te
komen. Laat je niet afschrikken door de
term HDR. Het klinkt misschien een
beetje eng. maar het is makkelijker dan
je denkt.

Om de basis van High Dynamic
Range te begrijpen. moet je eerst

64 PHOTO DIGITAAL

begrijpen hoe wij mensen dingen zien.
Stel je eens een goed verlichle plek
voor bij nacht. Mensen zijn in staat om
diverse kleurtinten te onderscheiden
in de schaduw en registreren ook
diverse variaties in de fel verlichte
gedeeltes. Vergelijk dit nu eens met
een digitale foto in dezelfde setting. Je
zult zien dat de schaduw hier
voornamelijk wordt weergegeven met
zwart en de meest heldere gedeeltes
met puur wit. Een digitale camera
heeft namelijk moeite met het
realistisch vastleggen van dergelijke
hoge contrasten tussen de donkere
schaduw en de heldere lichten. Dit
verschil in contrast wordt aangeduid
met 'dynamic range’ oftewel
dynamisch bereik.

Om een afbeelding met een hoog
dynamisch bereik te kunnen maken,
moet je een serie afbeeldingen maken
waarbij je verschillende belichtings-
instellingen gebruikt — van de diepe,
rijke schaduwen tot de felle lichten.
Lees snel verder en ontdek hoe je de
techniek toepast.




HDR:Debasis Specifieke HDR software

Bij afbeeldingen draait het altijd om Uiteraard gaan we je vertellen hoe je met Photoshop HDR-afheeldingen maakt, maar er bestaan ook
het behouden van zoveel mogelijk andere programma'’s die je kunnen helpen om dit effect te bereiken. Het meest bekende programma is
details, zowel in de schaduwen als Photomatix van HDRsoft. Deze op zichzelf staande software voegt je afbeeldingen autormatisch samen
in de hooglichten. Bij traditionele en biedt tal van mogelijkheden om contrast, verzadiging en tonen aan te passen. HDR-afbeeldingen
fotografie worden hier meestal met sterk verzadigde kleuren zijn vaak met dit programma gemaakt. Je kunt de basisversie gratis
filters voor gebruikt waarmee downloaden van www.hdrsoft.com. Hier vind je ook de premiumversies, die te koop zijn vanaf 99 dollar
de hoeveelheid licht en schaduw (ongeveer 60 euro).

kan worden gecontroleerd,

maar het resultaat wordt altijd

beperkt door de verschillende T ==
soorten beschikbare filters. Hoe ;

kan Photoshop hierbij helpen?

Met High Dynamic Range (HDR)

heb je de mogelijkheid om een h

aantal afbeeldingen met elkaar te e S e o " TonsMapsing-
combineren, zodat je de optimale e e
details uit elke foto kunt halen.
Elke afbeelding is gemaakt met
een andere belichting, zodat er
zoveel mogelijk details worden
verzameld. Zodra de foto's worden
gecombineerd, is het resultaat
een goed uitgebalanceerde, rijk
gedetailleerde afbeelding.

Foto 1 Foto 2 Foto 3 Foto 4
Sluitertijd: 4 seconden Sluitertijd: 8 seconden Sluitertijd: 15 seconden Sluitertijd: 30 seconden
Diafragma: f/11 Diafragma: /11 Diafragma: /11 Diafragma: f/11

- LAATSTE PIERFOTO
VLOEIENDE TONEN Hier zie je duidelijk dat je

De kleuren van de lucht lopen het beste van beiden krijgt

nu geleidelijker in elkaar over - rijke schaduwen, maar ook
gedetailleerde hooglichten.

Door de lange sluitertijden
wordt de beweging van de zee
weergegeven als een vloeiend,

glasachtig opperviak.
GECONTROLEERDE PP
HOOGLICHTEN
Deze lichten zijn verzacht
naar een gloed in plaats
van een felle glans.
v
- - . ' -_.
# L ¥ . o == == v

"“*:_ﬁ:fg":,“;-_. .'—

| TT S : s A T e

| VERMINDERDE RUIS ,
| De ruis van Foto 2is SCHADUW DETAILS |
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Tutorial

In de wereld van de
HDR-fotografie is Ryan
McGinnis een echte pro.
Als enthousiaste stock-
fotograaf heeft hij ge-
noeg kunnen oefenen om de kunst van
HDR te perfectioneren.

"Ik benin "99 begonnen met fotografie.
Ik ben een gepassioneerde stormfoto-
graaf; het weer hier op het platteland van
Nebraska vind je nergens anders ter we-
reld — enorme hagelbuien, rukwinden en
tornado’s met een reikwijdte van 2 mijl.
HDR geeft me oneindig veel belichtings-
speelruimte bij de postproductie van een
foto. Het legt alle details van een onder-
werp vast, zelfs bij extreem slecht licht.
Het is een techniek waarmee je buitenge-
wone afbeeldingen kunt produceren. Ik
heb een blog op http://backingwinds.
blogspot.com, een Flickr gallery op:
http://flickr.com/photos/digicana
(inclusief een seclie met HDR) en ik ver-
koop stockfoto's via The Photoshop Shel-
ter (http://psc.photoshelter.com/
user/digicana) en Alamy
(http://tinyurl.com/2zt37b).”

Waarom HDR-fotografie?

llk ben gek op extreem weer, Elk voorjaar
tuig ik mijn auto op met mobiel internet,
eenradar en GPS, enrij ik ruim een week
rond over de grote viaktes van Amerika,
op zoek naar de mooiste stormbuien.
Wanneer je foto's van een storm maakt,
zit er vaak een enorm verschil in de hel-
derheid van de lucht en die van de grond.
Mijn goede vriend en medestormijager,
Darren Addy, wees me op HDR als moge-
lijke oplossing. Dit bleek toch niet zo goed
te werken bij storm. Met de huidige
cameratechnologieén is het noodzakelijk
om meerdere foto's te maken, maar
stormwaolken verplaatsen zich te snel
tussen de foto's door. Toch ontdekte ik
tijdens al dat experimenteren dat zolang
het onderwerp maar op dezelfde plaals
blifft, je hele uitzonderlijke resultaten kunt
behalen met HDR. Deze techniek maakt
het mogelijk om afbeeldingen te maken
die met elke andere methode zeer lastig
of zelfs onmogelijk zouden zijn.

Wat vind je zo leuk aan dit medium?
Als fotograal probeer je altijd om de es-
sentie van een scéne of een bepaald mo-
ment vast te leggen. Een groot deel van
de kunst van het fotograferen bestaat uit
het werken rond de tekortkomingen van

Casestudy: Ryan McGinnis

foto maakt van een man die een dutje
doet in de schaduw onder een boom, op
een heldere dag. Maak je de foto zodat de
lucht helder blauw is, dan worden de man
en de boom bijna geheel zwart in de uit-
eindelijke afbeelding. Zorg je ervoor dat
de man en de boom niet geheel zwart
zijn, dan wordt de lucht niet meer helder
maar krijglt deze een verwassen, wit ef-
fect. Fotografen gebruiken al jaren de
meest geavanceerde flitsers en reflecto-
ren, maar het blijfft een feit dat camera’s
nooit zo goed zijn als het menselijk cog in
het vastleggen van alle details van een
scene. HDR biedt hier de oplossing. Met
HDR leg je alle details vast en kun je in het
eindproduct net zoveel of weinig laten
zien als je zelf wilt. Het is veel werk, maar
zodra je het eindresultaat ziet, weet je dat
het de moeite waard is.

Waarom geef je de voorkeur aan Pho-
toshop boven andere HDR-software?
Ik heb een aantal andere programma'’s
geprobeerd, maar ik kwam er al snel ach-
ter dat deze voor een groot gedeelte zeer
beperkte mogelijkheden hebben in de
uiteindelijke omzetting van de afbeelding.
Metl Phetoshop heb je de mogelijkheid

NYC SCULPTURE:

om de curven aan te passen terwijl je een
HDR-bestand emzet naar TIFF. Hierdoor

heb je veel meer controle dan bij de ove-

rige programma’s.

Bovendien ziet het eindresultaat er bij
Photoshop een stuk realistischer uit dan
bij andere programma’s. Wanneer je op
zoek gaat naar HDR-folo's, kom je er al
snel achter dat veel hiervan gemaakt
zijn mel Photomatix. Dit programma
maakt naar mijn mening hele opzichtige
en onrealistische afbeeldingen. Hoewel
het grote publiek dit mooi schijnt te vin-
den, doet het mij erg denken aan de
periode dat het filter Zon (Lens Flare)

KEARNEY HOME:

Een huis in Kearney,
Nebraska, oktober 2006.
© Ryan McGinnis

de technologie. Ik bedoel, stel dat je een

Een sculptuur van Marc Di Suvero in New York City, september 2006. © Ryan McGinnis
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werd gemntroduceerd door Photoshop.
ledereen begon plotseling in het wilde
weg lens flare toe te voegen aan hun
afbeeldingen. Als dit niet subtiel wordt
gedaan, ligt de nadruk alleen nog maar
op het filter en niet meer op de daadwer-
kelijke afbeelding. Photoshop is geen
eenvoudig programma en het kost veel
tijd en moeite om het goed onder de
knie te krijgen, maar iedereen die ermee
werklt weet dat dit op de lange termijn
absoluut de moeite waard is.

Termen als ‘bits per kleurkanaal’
schrikt veel mensen af. Wat wordt
hiermee bedoelt?

Computers draaien allermaal op eentjes
en nullen. Wanneer een computer na-
denkt over een kleur, geeft hij hier een
nummer aan, of beter gezegd een serie
nummers. Alles wat je ziet op je scherm
bestaat uit een mix van de kleuren rood,
groen en blauw. Voor de computer zijn dit
kanalen. Wil je bijvoorbeeld een mooie
kleur geel, dan zegt de computer tegen
zichzelf: "mix rood #37 met groen #44
enblauw #6."

Het aantal bits per kleurkanaal geeft
aan uit hoeveel kleurtinten de computer
moel kiezen wanneer je een bestand
opslaat. Hoe meer kleurtinten hoe beter,
vooral wanneer je van plan bent om de
afbeelding nog uitgebreid te bewerken.
Dit kun je zien als een soort 'kleur-
resolutie’. Nel zoals een bestand met een
hoge resolutie door de hoeveelheid pixels
verder uitvergroot kan worden zonder
wazig te worden, kunnen de kleuren in
een afbeelding met meer bits per kanaal
beter bewerkt worden doordat er meer
kleur in zit. En net zoals je dat kleine
plaatje, alkomslig van een website, nooit
geschikt kunt maken voor een poster-
formaat, zal het converteren van een
afbeelding van 8-bit naar 16-hit het aantal
daadwerkelijke kleuren in een afbeelding
nooit vermeerderen.

Een van de grote voordelen van HDR is
dat een HDR-bestand niet alleen kleur-
informatie opslaat, maar ook helderheid-
informatie. Er bestaat in feite geen limiet

Meer zien?

Op http://backing
winds.blogspot.com vind je de
portfolio van Ryan McGinnis. Neem
ook eens een kijkje op zijn Flickr
site: http://flickr.com/photos/
digicana, http://psc.photoshelter.
com/user/digicana (Photoshelter)
en http://tinyurl.com/2zt37b
(Alamy).

met betrekking tot de hoeveelheid kleur-
en helderheidinformatie er kan worden
opgeslagen in een enkel HDR-bestand.

Hoe zou jij het begrip ‘tone mapping’
willen omschrijven aan de gewone

Met “Tone mapping’ zorg je ervoor dat
een HDR-afbeelding er correct uit zien op
een modern beeldscherm of print. Laten
we even teruggaan naar het voorbeeld

duw van een boom op een heldere dag.
Onze ogen en hersenen werken stukken
beter dan de duurste camera en compu-

de zon. Kijken we naar hetzelfde plaatje ogen.
op de computer, dan zien we ofwel een
blauwe lucht en een man die compleet
verborgen is in de schaduw, of een zicht-
bare man met een geheel witte, veel te
felle lucht. In tegenstelling tot onze ogen
kan een camera al deze details nietin
een opname vastleggen.

Maak je meerdere opnamen, dan leg-
gen de HDR-bestanden alle details vast
- de slapende man, de wolken in de
lucht, de vorm van de zon, etc. Onze
beeldschermen zijn echter nog steeds
niet goed genoeg om de scéne realistisch
weer te geven, Dat is eigenlijk niet zo gek.
De zon is tenslotte fel genoeg om je net-
vlies te verbranden, maar op je scherm of
in een tijdschrift kun je net zo lang naar
de zon staren als je wilt zonder bang te
hoeven zijn dat je je ogen beschadigd.
Alleen als we een magische monitor had-
den die dingen net zo licht of donker zou
maken als we zelf willen, zouden we de
scéne exact kunnen namaken,

Het uitzicht op Derwent Water (met Kewick en Skiddaw in
de verte) van Surprise View bij Ashness Bridge in Cumbria,
Engeland, December 2007 \

Helaas is dit nog niet mogelijk met de
huidige generatie monitoren (wellicht
dat dat in de komende 15 jaar gaat
veranderen...) dus zijn we genood-
zaakt om ‘tone mapping’ te gebruiken
om de afbeelding enigszins te doen
man? overeenkomen met helgeen onze
ogen zien. Met 'tone mapping’ pers je
het dynamisch bereik van de afbeel-
ding als het ware samen. Met andere
woorden. het maakt de lichte onder-
van de man die een dutje doetinde scha-  delen donkerder, en de donkere onder-
delen lichter, om meer visuele details
naar boven te halen. Dit doe
|e totdat de afbeelding

ter, dus wij kunnen de manin de schaduw  op het scherm over-

perfect zien. Ook zien wij een helder blau-  eenkomt met dat wat je

we lucht met daarinen eenfelle cirkel van  kunt zien met je eigen

roo

=




Dankzij de optie
Samenvoegen tot HDR
in Photoshop behoren
te donkere luchten

en schaduwen tot het
verleden

optip
I ic o en G
Heb je een HDR afbeelding
gemaakt van een 32-bit bestand
met handmatig doordrukken
en tegenhouden, dan moet je
deze afbeelding vervolgens
converteren naar 16-bit
zonder compressie.

Er bestaan twee opties om te werken met HDR-afbeeldingen . Bij de
eerste laat je de afbeelding in de 32-bit modus en bewerk je hand-
matig de schaduwen en hooglichten met Doordrukken (Burn) en
Tegenhouden (Dodge), zodat de details weer zichtbaar worden in de
16-bit modus die je scherm weergeeft. Deze details zouden normaal
gesproken voorgoed verdwenen zijn, maar komen op magische wijze

weer tevoorschijn als je het volledige HDR-bereik hebt vastgelegd.
De tweede optie bestaat uit het converteren van de afbeelding door middel

. van een van de semi-automatische methodes die Photoshop aanbiedt in het

HDR-dialoogvenster. Van deze opties is alleen (Lokale aanpassing (Local
Adaptation)) de moeite waard.

_ In onderstaande tutorial behandelen we beide methodes.

RYANS
TIP TOP 5

1. Gebruik een stevig statief

Als je camera beweegt bij het maken van de fotoserie, moet je
volledig vertrouwen op het automatisch uitlijnen in Photoshop.
Dit werkt niet altijd even goed en duurt vreselijk lang. Dit kun je
voorkomen door ervoor te zorgen dat de camera stevig staat.
Wat ook wil helpen is het gebruik van een afstandsbediening.
Dit voorkomt dat de camera heweegt, elke keer dat je een foto
neemt.

2. Stel je camera in op Handmatig (Manual)
Hiermee schakel je het zelfdenkend mechanisme van de
camera voor het grootste gedeelte uit, en dat is belangrijk bij
HDR. Een camera past de instellingen constant aan op basis
van wat er door de beeldzoeker te zien is. Bij HDR-foto's moeten
de instellingen voor elke foto exact hetzelfde zijn, behalve de
sluitertijd. Deze gebruik je om met de belichting te variéren.

<. Maak foto’s in RAW

Dit is eigenlijk een goede tip voor elke fotograaf. RAW
bestanden werken beter met HDR omdat ze veel meer
informatie opslaan over het licht in de foto. Hierdoor heeft het
eindresultaat veel minder artefacten.

Maak minimaal drie foto’s
Maak één foto met de juiste belichting, één te donker en één te
licht. Maak de foto donkerder door de sluitertijd te verhogen
en lichter door deze te verlagen. Heb je veel tijd en een beetje
verstand van fotografie, dan maak je nog een aantal extra
foto's.

5. Controleer de instellingen

Zorg er altijd voor dat Adobe Camera Raw is ingesteld op 16-bit
en dat elke foto dezelfde kleurtemperatuur heeft voordat je de
foto's met Samenvoegen tot HDR gaat laden. Je doet dit door
de instellingen aan te passen voor één foto, de rest te selecteren
en te klikken op Synchroniseren. Het is ook mogelijk om dit

in Bridge of Lightroom te doen docr de Ontwikkelinstellingen
(Develop) te kopiéren en plakken.
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Bestanden uitzoeken Zodra je een

serie foto's hebt gemaakt om een
scéne vast te leggen (minimaal vijf), ga je
naar Bestand>Automatisch>Samenvoegen
tot HDR (File>Automate>Merge to
HDR). Klik op Bladeren (Browse) in het
dialoogvenster en selecteer de bestanden
die je wilt gebruiken (Raw-bestanden
werken het beste) met een Ctrl/Cmd-klik.

Ssmenvaegen tot HOR (100}

Brommen: Sunangevorpd ik

L

) Kies afbeeldingen Zodra je op Open
w klikt, verschijnt het venster met de
voorvertoning van Samenvoegen tot HDR.
Hierin staan alle afbeeldingen op volgorde
van belichting aan de linkerkant. Kijk goed
naar het gecomhineerde resultaat. Heb
je per ongeluk irrelevante afbeeldingen
toegevoegd, dan kun je ze verwijderen in
de filmstrip aan de linkerzijde .

Samenveegon G HOR
Borbtaden
Va5 e of mase bastinden ut ven sat bekchtngan om

samon th v00gen en Gen g Drirc Adrgu
(LR} afseeidng ta maben.

Gebruben Bgtenden

e,

/IPegg om bronzfeskdngen autematich ut ta inen

) Automatisch uitlijnen Nu heb je
de keus om de optie Poging om

bestanden automatisch uit te lijnen
(Attempt to Automatically Align Source
Images) aan of uit te vinken. Dit is altijd
een goed idee, tenzij je een hele zware
tripod hebt gebruikt en je camera op
afstand hebt bediend.

/1 Beoordeel de voorvertoning Door
&0 de schuif van het witpunt (White
Point) naar links en rechts te verplaatsen
in het histogram heb je de mogelijkheid
om te controleren of je alle noodzakelijke
details uit de schaduwen en hooglichten
hebt vastgelegd. Ontbreekt er iets, dan
ben je misschien een afbeelding vergeten
in te voegen, of moet je de scéne opnieuw
fotograferen.




Witpunt instellen Het punt waarop je

het witpunt instelt is de basis voor je werk
wanneer je de afbeelding handmatig bewerkt
met doordrukken en tegenhouden. Het is daarom
een goed idee om de schuifknoppen zodanig te
verplaatsen dat de middentonen precies goed
zijn. Negeer de schaduwen en hooglichten nog
even, want deze komen hierna aan bod.

De laag Doordrukken Dit brengt je weer
terug bij het startpunt en geeft je een
goede basis om de geselecteerde schaduwen

en hooglichten te bewerken met doordrukken

en tegenhouden, zonder de middentonen te
wijzigen die er al goed uitzien. Selecteer eerst de
Doordrukken laag en kies een penseel met een
Hardheid (Hardness) van 0%.

1 Verloop voor de lucht Klik op D om

% het Kleurenpalet weer in te stellen op
het standaard zwart en wit. Klik en sleep een
verloop vanaf de horizon, waar de lucht begint,
naar boven tot ongeveer halverwege. Verlaag de
Dekking van de laag tot het er realistisch uitziet,
of gebruik eventueel een sterk Gaussiaans
vervagen (Gaussian Blur) als je de sterkte niet
wilt verminderen.

v | Kanaten | Paden
Hormed - Dekki 100%

Vargra 4@ Wi 100%
» " stmam
BT

» [ Acvergond 8

#  Doordrukken en Tegenhouden lagen
%' toevoegen Laat de Bitdiepte (Bit

Depth) staan op 32-bit en klik op OK. Klik

op Nieuwe aanpassingslaag maken (Create
New Adjustment Layer) onderaan het
Lagenpalet, kies Belichting (Exposure) en
sleep de schuif helemaal naar links. Hernoem
deze laag Doordrukken. Voeg nog een zelfde
aanpassingslaag toe maar sleep de schuif dit
keer helemaal naar rechts. Hernoem deze laag
Tegenhouden.

*

Lantaarnpaal doordrukken Begin met

= het doordrukken van de lamp in de
lantaarnpaal, om zo wat van de noodzakelijke
details terug te halen. Zoom in op de afbeelding
en stel de penseel in op een Dekking van 50%.
Klik voarzichtig op de lamp en bouw op die
manier nauwkeurig de details op zonder de
omliggende gedeeltes te bewerken.

) De laag Tegenhouden Vervolgens is

£~ het tijd om de schaduwen bij te werken
dlE een beetje te donker zijn of geblokkeerd
worden. Het strand en de boulevard moeten
volledig lichter gemaakt worden, dus gebruik
je daar weer een verloop voor. Doe dit weer op
dezelfde manier als hiervoor, maar sleep het
verloop nu vanaf de kustlijn naar de bovenkant
van de flats achter de strandhuisjes.

Laagmaskers omkeren Het is niet mogelijk om

de laagmaskers van de lagen Doordrukken en
Tegenhouden om te keren met Ctrl/Cmd+l in de 32-bit
modus. Zoom daarom uit en kies een groot, zwart penseel
met een Dekking (Opacity) van 100%. Schilder hiermee
volledig over allebei de lagen.
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De Lucht{aag doordrukken Er zitten momenteel
« maar weinig details in de lucht, dus hier moet
veel doorgedrukt worden. Doe je dit handmatig met een
penseel dan laat dit veel sporen achter, dus kun je beter
gebruik maken van het gereedschap Verloop (Gradient).
Ook is er een aparte laag nodig voor de lucht, dus maak
deze aan en keer het laagmasker weer om, net zoals
hiervoor.

| “ De voorgrond tegenhouden Verminder de
= Dekking van de laag een klein beetje en kies

een groot, zacht penseel met een Dekking van 30%.
Schilder hiermee over de zee om weer wat van de
details terug te brengen. Zet de Dekking op 15% en
schilder ook over een stukje van het strand. Maak
het af door Afbeelding>Modus>16-bit>Samenvoegen
(Image>Mode>16-bit>Merge) te kiezen. Laat de
instellingen staan en maak nog een paar .
aanpassingen in het Contrast in de 16-bit modus. PP
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ﬂ Start opnieuw We beginnen nu
é’ opnieuw om de tweede methode
uit te leggen. Ga daarom weer naar
Bestand>Automatisch>Samenvoegen tot
HDR (File>Automate>Merge to HDR) en
selecteer dezelfde bestanden via Bladeren
(Browse). Vink automatisch uitlijnen aan
en kies Open. Laat het witpunt staan en
verander de 32-bit modus naar 16-bit.

I S I
D]

Ultvoer: 100

L L T

Invoer: 85 % % [ |Hoek

4"} Stel het witpunt in Doe nog een
j 4 keer hetzelfde voor de hooglichten.
Sleep het punt linksboven op de curve
naar links tot aan de rand van de
hooglichteninformatie. Ga ook hier niet

te ver. De standaardinstellingen van de
schuifknoppen kun je laten staan.

HOR-omzetting

Mathoda:  Lokals asnpassing -

Stral:

# Kleurtoorcurve en histogram

Irvoer; &8 % Uitwoer: 71
:;g @ Controleer de schuifknoppen
e Wanneer je klaar bent met de
curve is het de moeite waard om de
schuifknoppen nog even te controleren,

om het effect te bekijken op de afbeelding.

Afhankelijk van het type afbeelding wil je
de Drempel (Threshold) misschien nog
verlagen of verhogen. Hiermee geef je het
geheel bijvoorbeeld een zachte, wazige
look of haal je lichtkransen weg. De Radius
schuif is ook de moeite waard om mee te
experimenteren,
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Drempel!
A J|Voorvertening

4 Kleurtooncurvs en histogram

~ Kies de conversiemethode We

see gaan nu verder met de conversie.
Dit keer opent er een dialoogvenster
met opties om 32-bit naar 16-hit te
converteren. Kies Lokale aanpassing
(Local Adaptation) uit het drop-down
menu en klik op de knop onder de
schuifbalken om de Curven weer te geven.

HOR-omzetting YER
Meathade: Lokale aanpas: - -
aanpassing —&—]

Straal: | Annderen |

1 (= Stelhet
% % zwartpunt
in Sleep eerst de
eindpunten in het
Curvenhistogram naar
de informatie. Klik nu op
het punt links onderaan
op de curve en sleep
deze naar binnen, tot
aan het beginpunt van de
schaduwinformatie op
het histogram. Zorg dat je i
deze niet te ver doortrekt L . 13
want dan raak je details Invoett Bl % Uitvosr 0 o
van de schaduwen kwiijt.

{ B I 1= il el R

|Hoek

Toptip

Verwijder ruis

Het mooie aan de optie Samenvoegen tot HDR in Photoshop
is dat het ook ruis uit je afbeeldingen verwijdert. Terwijl de
ene afbeelding bovenop de andere wordt gestapeld, worden
de korrelige gedeeltes in de lagen automatisch opgevuld. Dit
maakt de afbeelding een stuk vioeiender.

Drempst: [ Opslan,.. |

ks /|Voorvertoring

& Kleurtooncurve en histogram

| P

T

Irwoer; 76 %% Uitvoer, 89

{» Controleer de kleurtonen De

W afbeelding zou nu een goed algeheel
contrast moeten hebben, met details in
zowel de hooglichten als de schaduwen.
Als je bepaalde gedeeltes van een
kleurtoon wilt aanpassen, dan kun je dat
op de bekende manier doen in het Curven
histogram. Houd Ctrl/Cmd ingedrukt en
klik op een kleurtoon in de afbeelding om te
zien waar deze zich bevind op de curve.

1. Scéne

Bijna elke scéne is geschikt voor HDR-fotografie.
Voor de meest indrukwekkende resultaten kun
je het beste een scene kiezen met een groot

contrast tussen licht en donker.

2. Voorbereiding

Maak een paar testfoto's tot de schaduwenin
het midden van het camera histogram staan.
Verminder vervolgens de belichting met 1 of 2

stops maak een tweede foto.

2. Instellingen

HDR-omzetting
Methode: Lokale sanpassing -
Straal; [ Annderen |
[ lagen.. |
[ Opshan... ]
/\Vioorvertoning

Drempsl:

% Kleurtconcurve en Histogram

Invoer: 68 %o Uitvoer: 71 k0 Hoek

L m Lg De curve manipuleren In dit geval besluiten we om een punt
#uat  inde curve aan te brengen in de donkere tonen om de kiezels
op te lichten. Ook zetten we er één in de middentonen en nog een
volgend punt in de hooglichten om de lucht donker te houden. Je kunt
er net zoveel toevoegen als je wilt en op die manier meer extreme
aanpassingen maken dan mogelijk is in de 16-bit modus.

Snelle HDR-tips

4. Andere instellingen

Compressie wordt gebruikt om ervoor te
zorgen dat alle details uit de hooglichten
worden behouden, maar het biedt zelden

een goed resultaat omdat de afbeeldingen
over het algemeen te donker zijn. Je kunt
dezelfde techniek beter toepassen met de
functie Lokale aanpassing (Local Adaptation)
in Photoshop. Histogram egaliseren (Equalize
Histogram) zoekt de pieken in het histogram
ensmeert deze uit, zodat de meerderheid van

Blijf de belichting verminderen met 1 of 2 stops
en ga door tot je alle details van de hooglichten
binnen het histogram kunt zien. Zorg dat je
minimaal drie verschillende belichtingen hebt
gebruikt.

de pixels een contrastboost krijgen. Het effect
is indrukwekkend, maar heeft vaak de neiging
om het bereik aan beide zijden naar elkaar toe
te halen, waardoor er te zware schaduwen en
hooglichten ontstaan. I




